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Introduction 
 
Welcome to PowerPoint: Beyond the Basics! I have attempted to continue teaching PowerPoint in a 
project based learning environment incorporating subject areas most appropriate to the upper 
elementary grades, middle school and high school. 
 
We, as teachers, know that students tend to learn effectively when they are actively engaged in their 
own education. The more students participate in the lesson, the better they will retain what they 
have learned.  
 
When technology is used in the classroom to promote student involvement in their own learning, 
the more learning proceeds. By using PowerPoint, students will truly be empowered to learn. 
 
PowerPoint: Beyond the Basics is arranged in a sequential manner with each project introducing or 
reinforcing a PowerPoint concept.  A listing of the PowerPoint concepts emphasized in each project 
appears at the beginning of the project. You can use the projects out of sequence if you prefer, by 
modeling the concepts emphasized for the students.  
 
The project directions act as frameworks for the students.  I’d expect students to use their own 
creativity to elaborate using the framework, and let their imaginations soar.  Adapt the directions to 
meet your own requirements whenever needed.  
 
I have included rubrics for ease of assessment, a summary of copyright laws, and a style check off 
form for student use.  
 
I hope you find this book a valuable asset to your classroom library. You can contact me with any 
questions and/or comments through FTCPublishing.com. Just scroll to the bottom of the first screen 
of their website, and click on “Ask Marsha.” 
 
Marsha Lifter MA 
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Copyright and Fair Use Guidelines 

 
When creating a multimedia presentation, there are several copyright laws of which you must be 
aware of as a student. Below are the laws that should most concern you: 
 
Video: for integration into multimedia or video projects 

1. Students “may use portions of lawfully acquired copyright works in their academic 
multimedia,” defined as 10 percent or three minutes (whichever is less) of “motion 
media.” 

2. The material must be legitimately acquired: a legal copy (not bootlegged) or home 
recording. 

3. Copyright works included in multimedia projects must give proper credit to copyright 
holder. 

 
Music: for integration into multimedia or video projects 

1. Up to 10 percent of a copyright musical composition may be reproduced, performed, and 
displayed as part of a multimedia program produced by students. 

2. A maximum of 30 seconds per musical composition may be used. 
3. Multimedia program must have an educational purpose. 
 

Internet 
1. Images may be downloaded for student projects. 
2. Sound files and video may be downloaded for use in multimedia projects. Ten percent or 

three minutes whichever is less. 
3. Resources from the Web may not be reposted onto the Internet without permission, 

however, links to legitimate resources can be posted. 
4. Any resources you download must have been legitimately acquired by the Web site. 
 

Illustrations and Photographs 
1. Single works may be used in their entirety, but no more than five images by a single 

artist or photographer may be used. 
2. From a collection, not more than 15 images or 10 percent (whichever is less) may be 

used. 
3. Although older illustrations may be in the public domain and don’t need permission to 

be used, sometimes they’re part of a copyright collection.  
 
My thanks to Hall Davidson for his work in helping teachers and students understand and use the 
copyright laws correctly. More guidelines and copyright resources are available at 
www.halldavidson.net. 
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Style Check-Off Sheet 
 
As you finish your PowerPoint presentation creation, use this form to make sure that you have 
followed good basic design rules. Although there are exceptions to every rule, presentations look 
best when the basic rules are followed. 
 
FONTS 
Yes      No 
      1 or 2 sizes per screen 
      1 or 2 colors per screen 
  Consistent use of fonts throughout 
  Large enough to see from back row 
 
BACKGROUND 
Yes        No 
             Does not conflict with text 
  Text and background contrast 
 
COMPOSITION 
Yes        No 
  Screens are simple and clear 
  Plenty of line spacing and generous margins 
  Short phrases and key words 
  No more than 6 lines of text per screen 
  No more than 6 words per line 
 
 
SPECIAL EFFECTS 
  Yes       No 
  Consistent in use of special effects 
  Too many different effects 
 
 
STYLE APPLICATION 
  Yes      No 
  Uses pictures 
      Uses charts, graphs 
  Too much text 
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Book Report 
 
 
What’s the Main Idea? 

Using PowerPoint to present a book report is a multimedia alternative to a pencil and paper 
report. In the presentation you not only acquaint your classmates with the book you read, but 
you also present in such an interesting manner as to entice your classmates to want to read 
the book. 

 
Focus PowerPoint Skills Addressed: 

This project reviews the basic tools in PowerPoint that you most likely already know how to 
use.  

-Inserting a text box   -Adding clip art 
-Changing text color and style -Creating with Auto Shapes 
-Using the WordArt option  -Recording a Sound 
-Using the Picture Toolbar  -Adding a Background 
-Using animation   -Printing a PowerPoint Slideshow 

 
The example for this project uses the book Hatchet, written by Gary Paulsen. 
 
Internet Resources: 

www.awesomeclipartforkids.com 
www.kidsdomain.com/clip 
www.findsounds.com 
www.acs.ucalgary.ca/~dkbrown/authors.html 
www.google.com for images 

 
 
Procedure: 
Complete the planning form for The Book Report project. Be sure and list the web sites that have 
graphics you want to use. 
 

1. Create a folder named “Book Report Graphics.”  Locate the graphics you want to use from 
various web sites, and save those graphics in this folder. This keeps all your graphics in one 
place for easy access. 

 
 
Slide One – The Title slide: 
This is where you state the title of the book, the author’s name, the date the book was published, 
and your name as the creator of the presentation.  In designing this screen, you might want to think 
of colors associated with the story. 
 

1. Open PowerPoint and select Blank Presentation.  Then select AutoLayout with Title and 
Sub-title. 
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2. If the Toolbars listed below do not show on your screen, follow these directions:   

     Select View on the Menu Bar. Choose Toolbars from the drop down menu and  
     select the following toolbars: 

  Standard   Picture 
  Drawing   Formatting 
  Animation Effects 
 

3. Click on the title box, and then type in the title of your presentation.   Click and drag your 
mouse to highlight the title, and then choose a different font you want to use.  In the subtitle 
area, type in the name of the author of the book. 
 

4. In the Drawing toolbar, choose the Text Box tool. You can also find it on the Menu Bar 
under Insert, then Text Box. 

 
5. Draw a small text box at the bottom of the screen, and then type in your name as the author 

of this presentation. 
 

6. Create another small text box in the other bottom corner of the screen to enter the date of 
publication. 

 
7.  To add a background to your slide, select Format on the Menu Bar and choose   
     Background.  

 
Once Background is chosen, select a color.   
 
After you choose your color, select an Effect, and then click  
Apply. 
 

8. This is a good time to save your work.  Click on File and select   
     Save.  Save your  PowerPoint file to your folder on the computer 
     hard drive.   

 
 
Slide Two: 
On this slide, you begin to tell your story in both words and graphics, as to the setting in which the 
story occurs.  You want to use descriptive words to help your viewer visualize the atmosphere of 
the story. 
 

1. To create the second slide, click on Insert and select New Slide.  Select the Title Slide 
format.  Type in “The Setting.” 

 
2. Use the skills you have already learned to change the font, style, color, and size of the text. 
 



 12

3. Click on the Text Box icon from the Drawing toolbar, or click Insert from the menu bar and 
select Text Box.  Click and drag a new text box near the bottom of the screen. Type in the 
information about the setting of the story from your Book Report Planning Form.  

 
4. If the setting is outdoors, or even in another country, try to find a graphic appropriate for this 

setting. Once you have found the graphic you want to use, whether from another application 
or from the Internet, save that graphic into your folder on the hard drive.  Once it is saved on 
the hard drive, click on Insert on the menu bar, select Picture, from File, and then navigate to 
the graphic.  Once selected, click on Insert. 

 
5. If you want the graphic to be the background for the slide, select Format and choose 

Background. From the Background menu, click the down arrow and choose Fill Effects. 
Click the Picture tab and maneuver to the folder with your picture. Click Apply and you now 
have a picture as your background.   

 
6. Insert a new slide from Insert on the main menu bar. Select the Blank slide format from the 

New Slide menu.  
 
 
Slide Three: 
Here you are listing the main characters in your story.  
 

1. Click on the WordArt icon in the Drawing Toolbar. You can also access WordArt from the 
Menu Bar. Select Insert, Choose Picture and pull to the right to select WordArt.  

  
2. Select a Word Art style you like. Click OK.  

 
3. Type in your screen title, “Main Characters.” You should see 

a WordArt toolbar on your screen now. If you don’t. Select 
View, choose Toolbars and select Word Art. 

 
 
4. Select the color you want for your WordArt. Click OK. 
 
5. Select the Text Box, click and drag on the screen. Type in the name of the main characters.  

 
6. Now, create another text box and add information about the characters. 

 
             
7. To add a background to this slide, choose Background from the Format menu. Be sure the 

background isn’t too dark. 
 
8. If you don’t like the background you chose, select Edit and chose Undo.  
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9. You may want to view your slide show to this point. To view your slide show, select Slide 
Show and choose View Show.  

 
 

10. Save your file. Click on Insert and select New slide. Select the title slide format from the 
New Slide menu. 

 
Slide Four: 
Here you tell how the story begins and you graphically grab your audience.  
 

1. Type in your title. You might want to use: “The Story Begins” 
 
2. Make the slide graphically compelling by using some of the tools you are already familiar 

with. 
 

3. Use the text box to tell part of the story. 
 
4. Insert graphics that add to the story. Use the Picture toolbar to modify your graphic. 

 
 

 
5. To display the Picture toolbar, select View, choose Toolbar and select Picture. You might 

want to use the cropping icon to modify the size of your picture.  
 
6. If you need a shape graphic in your slide, select AutoShapes in the Drawing Toolbar. 

Choose Basic Shapes and click on the one you want.  
 

7. You can change the color of the shape fill. Select the Fill Color from the Drawing Toolbar. 
Choose the color you want and fill. Be sure and check out the Effects offered too.  

 
8. To add some sound to your slide, select Insert and choose Movies and Sound. You have the 

option of recording, inserting a sound from your files, or a sound from the PowerPoint 
Gallery.  

 
9. To record a sound, click Record and record your dialogue. Select Save when you are 

finished and a speaker icon appears on your slide. Move the icon to a place on the screen 
where it is not too obvious.  Whenever someone clicks on the speaker icon while viewing 
the slide show, your recording will be played.  You can also set the sound to play 
automatically. 

 
10.  Add your background from the View menu. 

 
11.  Save your file. Add a new slide. 
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Slide Five: 
On this slide you continue the story by listing the main events. Here you tell of the cause and effects 
that make the story unique and enticing.  
 

1.  Add a title to the screen. You might want to use: “The Story Continues” 
 
2.  Use the Text Box tool to add your text. 

 
3. To add a graphic in a specific shape or to add text in a shape, use the AutoShape tool. To 

add a picture within the shape, select the arrow to the right of the Fill Color icon. From the 
menu, choose the Fill Effects and then the Picture tab. Maneuver to your picture in the 
folder and Apply. Your shape now has the picture within it.  

 
4. To add words in front of the shape, select the Text Box icon and click and drag within the 

shape. Type in the words. 
 

5. To use a speech bubble, select Callouts from the AutoShape tool. Click and drag to create 
your bubble. Change the color of the bubble by using the Fill Color icon. You can rotate the 
speech bubble very easily. Click to highlight the bubble. Select the Free Rotate icon from 
the Drawing Toolbar. Click on one of the handles on the bubble with the Free Rotate icon 
and move it.   

 
6. Save and insert new slide.  

 
Slide Six 
Here you continue with your presentation of the story. You are leading up to the ending, so make it 
dramatic using graphics, sound and animation. 
 

1. Create the title, text and insert the graphics to continue with your story. 
 
2. To animate one of the graphics, click on the graphic first. Select Custom 

Animation from Slide Show on the Menu Bar. A Custom animation dialog 
box appears on the screen.  

 
3. Notice on the left there is a list of pieces of your screen.  As you click on 

one, it is shown in the picture to the right. From the drop down menu 
select how you want the graphic animated. 

 
4. Click on the Order and Timing Tab and choose how you want the 

animation to occur.  
 

5. You can click Preview to see how it will look. 
 

6. Save and insert new slide. 
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Slide Seven 
This slide is where you end the story. Design your slide so the ending has impact. 
 

1. Use the Text Tool to tell the final events of the story. Make it dramatic. 
  
2. Choose a background that adds to the story.  
 
3. For this slide, let’s make the title move dramatically onto the screen. 
 
4. Choose Custom Animation from the Slide Show menu. From the choices on the left, click 

the title. 
 
5. Click the Order and Timing tab, then choose how you want the title to enter. 
 
6. To add a sound effect to enhance the drama of the final story screen, select Insert and 

choose Movies and Sounds.  Navigate to the location on the hard drive where your sound 
file is located.  Click on the sound file and click Insert. You can also choose to play a CD 
during your presentation.  To do this, click on Insert, then Movies and Sounds, then select 
Play CD audio track.   

 
7. Save and insert new slide. 

 
 
Slide Eight 
This slide is the author’s part of the story. You can import a picture of the author from the Internet 
and add it to this screen. Having a picture of the author helps your viewers to understand more 
about the story.  
 

1. Create your title. 
 
2. Add background that gives a feeling for the story. 

 
3. Add a picture of the author. 

 
4. Add text that either tells something about the author or asks questions as if he or she were 

talking to your viewers. 
 
 
Slide Nine 
Here you involve your audience in the presentation. You want to make it a strong thought 
provoking experience. 
 

1. Use all the skills you have demonstrated on the other slides to make a slide that is visually 
intriguing. 

 
2. For the title, you might want to use WordArt and make it very special. 
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3. Select the WordArt toolbar from the View menu. Use some the of options you can do with 

WordArt. 
 

4. Save and insert new slide. 
 
 
Slide Ten 
For this slide you design a poster you can use to advertise your book selection. 
 

1. Design a slide that acts as an advertisement for the book. You can use the tools in 
PowerPoint or you might use a drawing program to create the slide. 

 
2. Use WordArt, backgrounds and strong graphics to create this screen. 

 
 
 
Viewing the Book Report Slide Show: 
 

1. Click on the Slide sorter icon on the Drawing toolbar and view all of your slides together on 
the screen. 

 
2. If you don’t like the position of a slide, just click and drag it to where you want it placed. 

 
3. To view your show, select Slide Show and choose, View Show. 

 
 
Printing your Slide Show: 
 
You have many options for printing your slide show.  
 

1. To print with 6 slides to a page, Select File and choose Print. 
 
2. Go to Print what: 
 
3. Select Handouts. 

 
4. In the Handouts dialog box, choose Horizontal or Vertical and the 

option of 6 slides per page. 
 

5. You can also choose 2-9 slides per page. 
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Extensions: 
 

1. Save your presentation as Pack and Go and then save to a disk that can be shared with 
others. 

 
2. Save as a Web Page and then your presentation is saved in HTML and can be published on 

the Internet. 
 

3. Save as a Send To and a submenu is displayed that provides the options for sending the 
current file via e-mail. 

 
4. Print out as two to a page, cut the slides out and staple together into a small book that can be 

shared.  
 

Book Report Sample 
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A Book Report Planning Form 
 
 
This planning form can be used for any book report you want to create. 
 
Web Sites for this project: 
_____________________________________________________ 
_____________________________________________________ 
_____________________________________________________ 
_____________________________________________________ 
 
 
Slide 1: 
This is your title slide. 
On this slide you list the title of the book, the author, and the date published. Be sure and also list 
your name as author of the presentation. In creating this slide, you might want to think of the colors 
that best represent your book. 
 
________________________________________________________________________ 
________________________________________________________________________ 
________________________________________________________________________ 
 
 
Slide 2: 
Describe the setting for the story. Try to paint a picture for the audience so they can visualize the 
setting in their minds. Use words and graphics. 
 
________________________________________________________________________ 
________________________________________________________________________ 
________________________________________________________________________ 
________________________________________________________________________ 
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Slide 3: 
Your viewer needs to know something about the characters in the story. On this screen you name 
them and tell something about them.  List the main characters in the book and describe how they 
look.  Make sure to include descriptions of their personalities. 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________ 
 
Slide 4: 
The beginning of the story sets the mood and gets the viewer interested in what else you are going 
to say.  Write how the story begins. What is the main event that causes the events of the story?  
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
 
 
Slide 5: 
What are the major events of the story? What are some of the cause and effects of the story? 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
 
 
Slide 6: 
On this slide, continue with the story. Lead up to the ending. 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
 
 
Slide 7: 
This slide illustrates how the story ends. You might not want to tell the ending and just make your 
audience think about how the story might end. 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
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Slide 8: 
What do you feel is the message of the book? What values does the author suggest are important? 
On this slide write and illustrate what the author suggests are important values. You might want to 
include a picture of the author. 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
 
 
Slide 9: 
On this slide you ask questions to provoke discussion or thinking among your audience. Ask them 
how they would react if in the situation of some of the story’s principle characters. 
________________________________________________________________________________
________________________________________________________________________________
________________________________________________________________________________
________________________________________________ 
 
 
Slide 10: 
In a drawing program or using PowerPoint, create a poster advertising your book. The poster should 
make the viewer want to read the book. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


